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About SeeSnake® HQ™ 

Digital Technology 
Digital pipe inspection has some significant advantages over older analog recording 

techniques. One of the most powerful new capabilities made available by the 

transition to digital is the ability to easily distill key information from the pipe 

inspection process and report that key information to your customer in an 

understandable way. SeeSnake® HQ™ is designed to augment your workflow and 

enhance your ability to deliver professional-quality reports.  

 

SeeSnake® HQ™ is a software tool made to help you collect pipe inspection content 

and impress your customer with a simple to create, yet clear and professional looking 

report. This software has the potential to greatly enhance the way you communicate 

the results of your inspections to your customers.  You can also use it to easily 

organize and store your jobs for future reference.  
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The workflow of SeeSnake® HQ™ is simple. The basic component of SeeSnake® HQ™ is 

a Job. A Job is made up photos and video clips taken from SeeSnake® pipe inspection 

equipment such as the LT1000.  

The primary output of SeeSnake® HQ™ is a Report. There are three types of reports 

and multiple distribution methods you can use to communicate information to your 

customer. Basic Reports can be emailed, printed, or exported.  

 

Standard Reports distributed via email or print should contain only still photographs 

and text.  Standard and Autolog video can be included in Reports when exported as 

HTML.  Your customers will be able to view the HTML reports using their web 

browser. The second type of report you can make is a DVD Report. Creating a DVD 

Report is more involved and time-consuming than the other types of reports, but may 

be best for customers who need video content and do not have computer access. The 

final report type is Upload.  Upload Reports are designed to work with 

RIDGIDConnect™.  You can use the Upload report type to send entire reports or 

individual photos or video to the RIDGIDConnect™ website which you can then share 

with your customer.  

This document will guide you through the basics of how to fully leverage the 

advantages of pipe inspection through the SeeSnake® HQ™ software. 
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Installation and Updates 

Windows XP 

If you are installing on a computer running Windows XP you will be prompted to 

reboot your computer. Save any open work and close any open applications and 

then click OK to reboot. Once you have successfully rebooted your computer 

installation with continue automatically.  

Windows Vista 

The installation process for Windows Vista is the same as Windows 7.  

Windows 7 

Insert the SeeSnake® HQ™ installation disk into the computer’s CD or DVD drive to 

begin the installation process.  If you do not have a physical CD you can download 

the most current version of SeeSnake® HQ™ from our website: 

http://www.hq.ridgid.com/product-hq.php 

After downloading double click setup.exe and follow the on-screen prompts for 

installation. You will want to select Yes, Next, and Finish where applicable. This 

process will install both the software and the drivers required to use the LT1000 

with SeeSnake® HQ™.  

  

http://www.hq.ridgid.com/product-hq.php
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The Home Window 

The Home Window is where you will manage and organize all your jobs from.  

 

 

   
Home Toolbar 

 
Job Space Manager 

 
File System 

 
Job List 

 
Job Path and Preview 
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Home Toolbar 

 
 

a. Menus: use the File menu to access and manage your jobs; the Edit menu 

to move, manipulate, and filter your jobs; the Tools menu to access 

settings, contacts, and troubleshooting tools; and the Help menu to get 

help, send bug reports, and check for software updates. 

b. New: Creates and opens a new empty Job  

c. Open: Opens the Job or Jobs selected in the Job List, alternately you can 

double click the job in the job list that you want to open  

 You can have up to three jobs open at a time 

d. Archive: Moves the selected Job or Jobs to the Archive  

e. Delete: Moves the selected Job or Jobs to the Job Recycle  

f. Find: Opens a window so you can search for a Job or Jobs with a filter in a 

particular job space  

g. Settings: Opens a new window where you can change various program 

settings.  

 

 Go to the next page to learn more about how you can 

customize SeeSnake HQ to suit your needs in the settings 

menu. 

  



SeeSnake® HQ™ │ User Guide 

 
 

Page │ 8 
 

Custom Settings 

You can customize many aspects of SeeSnake® HQ™ to fit your needs and 

preferences.  If you are unhappy with any changes you have made in a particular 

tab of the Settings menu simply click the Restore Defaults button and it will reset 

all the fields in the tab to their default settings. 

 

 Preferences: Language, distance formatting, auto save, 

general preferences 

 Video: Video quality, codec, frame rate 

 Overlay: Show overlay on video of count, date, and time, and 

specify their on-screen placement 

 Formatting: Choose what information will show up in reports 

for your contacts, and the format for addresses 

 Report: Customize the presentation  and style of PDF and 

HTML reports, add your logo and change colors 

 DVD: Customize a template for DVD reports, add your logo 

and an intro video 

 Email: Configure your email. Works for a Default Client, a 

POP3 Account, or a GMail Account 
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Job Space Manager 
 

                        

a. Job Space Header: click anywhere on this bar to collapse the list so that 

only the header is visible. Click a second time to show the list. 

 When collapsed there will be a number in parenthesis next to 

the Job Space header.  This number represents the number of 

Job Spaces.  There will always be at least three Job Spaces: 

Jobs, Job Archive, and Job Recycle. 

 
b. Jobs: This is the main/default job space.  

c. Custom Job Spaces: You can create as many custom job spaces as you 

would like to help you organize your jobs.  

 You can add a new custom job space by going to the File 

menu and selecting Add Job Space or by right clicking 

anywhere in the job list and selecting Add Job Space. 

 You can rename a custom Job Space by right clicking it and 

selecting Rename Job Space.  

 

 Custom Job Spaces containing Jobs cannot be removed. To 

remove a custom Job Space you must first move the jobs in it 

to another custom job space, the Job Archive, or Job Recycle. 

Then you can right click the custom Job Space and select 

Remove Job Space. 

d. Job Archive: drag and drop a Job or Jobs into the Job Archive for later 

reference. The Job Archive can be used as a storage system to help 

manage and organize past jobs.  
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e. Job Recycle: Jobs placed in the Job Recycle are not deleted from SeeSnake 

HQ or from your computer. There are multiple ways to send jobs to the 

Job Recycle: 

 Drag them from the job list to the Job Recycle icon in the 

Job Space.  

 With the jobs you want to delete selected click the Delete 

button on the Home Toolbar. 

 You can right click the selected job or jobs in the Job List 

and select  

 You will be asked to confirm that you want to recycle the 

job or jobs. 

f. Number of Jobs per Job Space: You can see at a glance how many jobs are 

in each of your job spaces.  

Job Recycle Toolbar 

The toolbar that appears at the top of the home window changes when in 

the Job Recycle Job Space.  

  

a. Restore: to return the selected Job or Jobs to their original 

location/Job Space click Restore. You can also restore a job or 

jobs by right clicking and selecting Restore Job. 

b. Delete: to permanently delete the selected Job or Jobs from 

SeeSnake HQ click Delete. You can also delete a job or jobs by 

right clicking and selecting Delete Job or by pressing the Delete 

key on your keyboard with the job or jobs selected.  

c. Empty: Click Empty to delete all the jobs in the Job Recycle.  

 Emptying the Job Recycle is permanent and cannot be 

undone! 

d. Date Recycled: SeeSnake HQ keeps track of when a particular 

job was recycled 

e. Original Location: the program also keeps track of the jobs 

original location.  
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File System 
 

 

a. File System Header: The File System will be collapsed/hidden by default. 

To show your computers file system click anywhere on this bar. Click a 

second time to hide the file system. 

b. File System Directory: This area will display your computer’s file system, 

the same thing you would see if you went to Start>My Computer in 

Windows. You can drag and drop jobs from your job list to a folder in your 

file system or drag jobs from a folder or device in the File System to a job 

space or job list. 
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Job List 
You can click any of the column headers to sort the job list by. You can customize 

which columns appear in your job lists according to your needs and preferences. To 

do this simply right click any of the headers or anywhere in the job list and go to 

Show/Hide Column Headers and check or uncheck the boxes next to the column 

names. You can restore the column headers to their default state by right clicking 

and then selecting Restore Column Headers. 

 

a. Select Job: click the box in the column header to select all the jobs in the 

current Job Space or click individual boxes to select specific jobs you want 

to apply an action to/ you want to do something with. 

b. Categorize: Use this feature to group jobs together by color. Sort them by 

clicking the column header.  

c. Customer Address: Often the customer’s address and the job location will 

be the same. In the event that they are not, the address that appears in 

the job list will always be the customer’s address. 

d. Modified: The date listed in this column reflects the last time the job was 

opened or edited in any way. 

Job Path and Preview 

 

a. Collapse Pane: click the box in the column header to select all the jobs in 

the current Job Space or click individual boxes to select specific jobs you 

want to apply an action to/ you want to do something with. 

b. Job Path: shows you where on your computer the selected job is being 

stored. 

c. Preview: this pane shows you a preview of all the photos and videos 

associated with the selected job. You can email an individual photo or 

video by right clicking the element you want to send and selecting Email, 

or by using the shortcut   
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The Job Window 

The Job window consists of two distinct areas: the Job Navigator on the left, and the 

View Port on the right. The most important thing to know about the way the Job 

Navigator interacts with the View Port is that whatever you select in the Job 

Navigator will be outlined in blue and appear enlarged as the active item in the Edit 

tab of the View Port. 

 

  



SeeSnake® HQ™ │ User Guide 

 
 

Page │ 14 
 

Job Navigator 
The Job Navigator is a collapsible pane on the left side of every job window. It can 

be collapsed by clicking the “Close” arrow on the Collapse Pane between the Job 

Navigator and View Port.  

   

   

   

   

   

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 
SeeSnake Live 

 
Job Data 

 
Session Data 

 
Media Element List 

 
Control Panel 

 
Collapse Pane 
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SeeSnake Live 

When another item in the Job Navigator is active in the View Port (outlined in 

blue) SeeSnake Live will expand to show a preview of the video feed from 

whatever camera is selected.  

  

a. Live preview of the video coming from your selected device 

b. Drop down of available video recording devices 

c. Drop down of available audio recording devices 

d. Click anywhere on this top bar to collapse/hide the preview (a) and 

capture controls (f) 

e. Distance as recorded by the CountPlus on your SeeSnake device. 

f. Convenient capture controls let you collect elements from the 

preview. 

 

When you are viewing SeeSnake Live in the View Port it will collapse and be 

outlined in blue highlight.  
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Job Data  

Selecting the Job Data thumbnail will make it the active element, outline it in blue, 

and place it in the View Port for you to edit.  

 

1. Job Information 

a. All jobs are named Video Capture Job by default. Rename the job here. 

The job name you enter here, unlike the session title you enter in Session 

Data, will not appear in reports. 

b. Enter any private notes you have about the overall job here. These will 

not show up in any report.  

2. Job Site Address  

c. Check this box to use the Customer’s address as the Job Site. 
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3. Customer Contact Information 

d. Click the Contacts icon if you already have the location or person’s 

information saved in SeeSnake HQ. New Job Site and Customer profiles 

will be created whenever you type new information into these fields.   

 Go to page X to learn more about adding and editing contacts. 

e. Click this bar to collapse the fields below. 

f. Auto-fill is enabled so that typing the beginning of a name or address will 

give you options if you have already done an inspection for that customer, 

or at that site and previously entered it in SeeSnake HQ. 

4. Inspector Contact Information 

g. The first time you use SeeSnake HQ fill out all your information here and 

then press the Set as default inspector button to have the program enter 

your information into all new jobs automatically. 
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Adding and Editing Contacts 

 

1. Customer Contact Information box from the Job Data page 

a. Click the address book icon to reveal a dropdown list of all the contacts 

you have entered in your contact manager. If you have already added the 

customer you can select them from the list and they will automatically fill 

out the fields for you. 

b. If you have not entered the customer’s information yet you can either the 

customer’s information in the fields and SeeSnake®HQ™ will automatically 

add the person to your address book for future reference or you can click 

Add a new contact from the drop down and open up the Contact Manager 

Window 

c. You can click anywhere in this box to expand the Customer Contact 

Information fields so you can add or edit information 
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Contact Manager Window

 

This window can also be accessed from the home window by 

selecting Contacts from the Tools menu. 

2. Browsing the Contact Manager 

a. Customer Profiles have the Customer icon  

b. Click to Add a new contact 

c. Click to Remove the selected contact 

d. Click to Edit the selected contact, the fields will become editable and the 

buttons 2b and 2c will change to 3f and 3g. 

3. Editing a Contact in the Contact Manager 

e. If you pressed the Set as default inspector button in Job Data your 

information will appear in the Contact list as an Inspector Profile with 

Inspector icon  

f. After editing a contact (2d), click Save to save your changes 

g. Click Cancel to cancel any changes made while editing a contact (2d),  
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Session Data 

Selecting the Session Data thumbnail will make it the active element, outline it in 

blue, and place it in the View Port for you to edit. Session Data is information you 

want included in reports for your customers.  
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Media Element List 

Any media you capture while doing an inspection will appear in the Media 

Element List. This includes photos, videos, and autolog videos. Just like SeeSnake 

Live and the Job Info far, active elements are highlighted in blue and enlarged in 

the View Port. 

Clicking the gear icon on a Large thumbnail or right-clicking anywhere on an 

element of any size will show the Element Options drop down menu.  

 

1. Active Media Element 

a. Currently included in the report, click to exclude. 

b. Send To this individual element to either RIDGIDConnect or an email 

address. 

c. Image is marked to headline the report, meaning it will appear on the 

report’s cover. Click the box to uncheck it. 

2. Active Modified Media Element 

a. Currently excluded from the report, click to include. 

b. Since this is a “modified” element (green thumbnail), and not a capture 

from the original inspection, it can be deleted. Original Media Elements 

(gray thumbnail) cannot be deleted. 

c. Properties will give you details about the photo or video. 

In the Element Manager you can choose to include or exclude media elements 

from reports. To exclude an element you can either click the blue checkmark in 

the top left corner of the element thumbnail once or right click anywhere on the 

element and select Exclude from Report in the Options drop down menu. Clicking 

a second time will include the excluded element.  
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Control Panel  

At the bottom of the Job Navigator is a control panel where you can customize 

how you view and sort the elements in your media element list. 

  
a. Sort: Sort media elements by distance (tape measure) or time (clock) 

b. Show/Hide: Show or hide excluded media elements. When the blue eye is 

visible, all media elements, both those marked included and those marked 

excluded, will appear in the media element list.  When the eye is gray, any 

media element marked “Exclude From Report” will be hidden, and thus 

not appear in the media element list. 

c. Thumbnail Size: Change the display size of the media elements in the list.  

 The default is medium. 

d. Units and Precision: Change the distance units and precision associated 

with your media elements. 

 New jobs will have their units and precision set according to 

the preferences in your settings menu. Individual jobs will re-

open in whatever units and precision they were set to when 

you closed them.  

Collapse Pane 

 

The Job Navigator can be collapsed or hidden to maximize your 

work area by clicking the arrow next to Close. To re-open the 

pane, click the arrow next to Open.  
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View Port 

 

View Port refers to the large area under the Edit and Report tabs where editing, 

recording, and reporting take place.   

View Port Toolbar 

 

  

1. Auto save Stamp: At the top of every job window next to the Job name is 

a time stamp of the last time that particular job was saved.  

2. Save: SeeSnake® HQ™ automatically saves open jobs every five minutes or 

more often if you are actively capturing new media.   

 If you have entered new notes, edited job or session data, or 

made any changes to media elements and try to close the job 

before the auto save has happened again, you will be prompted 

to save your work.  

 You can change the frequency that your jobs automatically are 

saved at by going to the Preferences tab in Settings and selecting 

one of four autosave intervals: 5, 15, 30, or 60 minutes. 

3. Settings: Opens up the Settings window as discussed on page 9. 

4. Home: Click to bring the Home window to the front of your screen. 
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Edit Tab 

Whatever you select in the Job Navigator pane will be outlined with a blue 

highlight and open in the Edit Tab of the View Port.  

Viewing SeeSnake® Live 

The edit tab is where you can view the full screen live video from a SeeSnake® 

camera, playback videos, create video clips, add audio notes, and add or edit text 

notes.  

 

A.  LT1000 Power: Indicates the amount of available battery life for the 

LT1000. 

B.  Computer Power: Indicates the amount of available battery life for your 

computer. 

C.  Current Date and Time: This clock sets itself according to your computer’s 

clock.  

D.  Live Settings: Opens up a window with various settings affective live 

video. 

E.  Distance: Displays the distance of whatever you are seeing onscreen as 

interpreted by the CountPlus. 

F.  LT1000 Capture Controls  

 Learn more about these controls on page AAA. 

You can access Full Screen mode by clicking .  You can exit full screen by 

pressing  a second time or by clicking the button that appears when you move 

your cursor to the top of the screen.  
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Editing Photos  

 

1. Preview of Photo 

2. Photo Editor: click to open the photo editor 

 Go to page AAA for a detailed explanation of how to use the 

Photo Editor 

3. Tabs: Photos in SeeSnake® HQ™ have two tabs: Notes and Audio Note 

a. Notes: Notes in the left box will appear in reports for your customer.  The 

right box is for any private notes about the photo. These notes are private 

and will not be included in any reports.   

 

b. Audio Note: You can record one audio note per photo explaining or 

commenting on it.  

 

c. Media Element with audio notes and text notes  will have icon 

badges in the Media Element List.  

 

 
 

4. Distance: gives the distance the photo was taken at 

5. Time: gives the time the photo was taken at 

  



SeeSnake® HQ™ │ User Guide 

 
 

Page │ 26 
 

Editing Videos and AutologVideos 

 

1. Snapshot: take a photo of the current playback frame of the video.  

a. Snapshots taken from video are considered modified media and appear in 

the Media Element List in green.  

2. Tabs: Videos and Autolog Videos in SeeSnake® HQ™ each has three tabs: Notes, 

Clips, and Properties. 

b. Notes: Notes in the left box will appear in reports for your customer.  The 

right box is for any private notes about the photo. These notes are private 

and will not be included in any reports.   

 

 

c. Clips: You can create short clips from long videos to add to reports. This 

enables you to highlight important things for your customers.  
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 Go to page AAA for a detailed explanation of how to create a 

video clip.  

d.  Properties: The Properties tab gives you additional information about 

your clip including the start time, duration, as well as the minimum and 

maximum distances. Additionally from this tab you can control the speed 

the selected video plays back at. Drag the ball right to increase the speed 

and left to decrease.  

 

d.  Video Playback Controls: The video playback controls under the video can 

be used to step through frame by frame or incrementally.  

3. Distance: gives the distance the current frame of the video/autolog video was 

taken at 

4. Time: gives the time the current frame of the video/autolog video was taken at 

 

Report Tab 

 

 

The type of report you create will depend on the type of media you want to 

include and how you want to distribute the report to your customers. There are 

three types of reports: Standard, DVD, and Upload.  
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Inspections with SeeSnake
®

 HQ™ 

LT1000 Integration 

SeeSnake® HQ™ and the LT1000™ were specifically designed to work with each other. 

Controls 

More often than not you will be able to run a basic pipe inspection using 

SeeSnake® HQ™ entirely from your LT1000. You can control many of the basic 

operations using the arrow keys. 

 

 
 

  

 
Photo Tag Key 

 
Menu Key 

 
Video Recording Indicator 

 
Job Management Key 

 
Playback Key 

 
Arrow Keys 

 
Select Key 

 
Power Key 

 
Microphone Mute Key 
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Photo Tag Key 

Press the Photo Tag key to add a note during an inspection.  Adding a note 

requires using your laptop keyboard to type the text. You can use the arrow keys 

to either save or cancel the note.   

 Save: If you select Save the photo will be added to the Media Element list 

with your note if you added one, or just the photo by itself.  

 Cancel: If you select Cancel neither the note nor the photo will be added 

to the Media Element list 

 

a. When you press the Photo Tag Key on the LT1000 a preview of the photo 

will appear with space to add a note below 

 

 

b. Media Elements that have notes added to them will appear with the 

Photo Tag icon on them in the Media Element List. 
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Menu Key 

Pressing this key will open up a window where you can edit various live settings. 

These settings can also be accessed by clicking the Live Settings icon in SeeSnake® 

HQ™  

 

c. Live Settings Menu 

Video Recording Indicator 

The Video Key on the LT1000 has a red LED integrated into the button. The light 

will turn on when you are recording video and will turn off when you stop 

recording.  The light only indicates for standard video, not autolog video.  

Job Management Key 

The Job Management Key will take you to the View Port’s Report tab.  

Playback Key 

The Playback Key opens up SeeSnake Live in the View Port’s Edit tab. 

Arrow Keys and Select Key 

Use the arrow keys and select key to operate the LT1000 and navigate SeeSnake® 

HQ™ during an inspection.  
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Power Key 

When you are done using the LT1000 you can turn it off by pressing the Power key 

 on the device.  

 

As a safety measure, the device does not shutdown right away. There is a ten 

second countdown that will display in a new window during which you can stop 

the shutdown process by clicking Cancel.  

 

You can override the countdown by clicking Shutdown and the device will turn off 

right away.  You can also press the Select key  on the LT1000 after pressing the 

Power key  to override the countdown. If you do nothing, the LT1000 will turn 

off after the ten second countdown is complete.  

 

Microphone Mute Key  

The LT1000 has a microphone built in. You can mute the microphone at anytime 

during an inspection by pressing the Microphone Mute key. This will cause the 

orange light next to the microphone icon above the key pad to turn off.  

 Remember to un-mute the microphone before trying to record 

an audio note.  
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Media Elements 

Recording and Capturing Elements 

Column A represents the capture controls as they appear in SeeSnake HQ. Column 

B represents the same controls but in their active or alternative state.  The C 

column shows the keys that appear on the front of the LT1000 as they correspond 

to the controls in SeeSnake HQ. 

 

1. Photo: Take a photo of the current view/video 

2. Photo Tag: Take a photo of the current view/video and easily add a text note 

and/or attach an issue tag. [Click here to learn more about issue tags] 

3. Video: press or click once to start recording a new standard video, press or click 

again to stop recording.  

 
Default LT1000 controls in HQ  
 

 
Activated LT1000 in HQ 
 

 
LT1000 Keys 
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4. Autolog: press or click once to start recording a new autolog video, press or click 

again to stop recording. Autolog videos are much smaller in size than standard 

videos and record at a rate of five frames per second (fps).  

5. Microphone: Toggles the microphone on/off  

 Microphone indicator light on the LT1000 is orange when the microphone 

is on and goes off when the microphone is muted. 

6. Sonde: Toggles the sonde on/off 

 Sonde indicator light on the LT1000 is green when the sonde is activated 

and remains off when it is not.  

7. Zero: Toggle between absolute count and relative count. 

 Relative Count: lets you measure the distance between two points by 

temporarily resetting the counter to zero.  

o Click or press the zero key/icon once. To return to the original 

count click or press one more time.  

 

 
Original Count 

 and  
Relative Count displayed in parenthesis. The zero icon in HQ is 
red. 

 
Original Count, adjusted to include the distance covered in 
Relative Count. 

 

 Absolute Zero: resets the counter to zero so you can essentially select 

your own starting point.   

o There are two ways to reset the counter to absolute zero. You can 

press and hold the zero key on the LT1000 or you can double click 

the zero icon in HQ.  

 Resetting the counter to absolute zero cannot be undone! 

8. Brightness: Step through LED brightness levels. 

 You can also use the arrow keys on the LT1000 to adjust the brightness by 

pressing the Brightness key and then using the arrows to fine tune the 

brightness setting. 

 
o Up/Right arrows increase brightness 

o Down/Left arrows decrease brightness 

 



SeeSnake® HQ™ │ User Guide 

 
 

Page │ 34 
 

9. Rotation: Rotate the camera view 

 Press the rotation button on the LT1000 to rotate the image 180°, use the 

arrow keys to rotate the image incrementally 

o Up/Down arrows increase or decrease the rotation angle by 30° 

o Right/Left arrows increase or decrease the rotation angle by 5° 

 Clicking the rotation icon in HQ adjusts the angle to reflect where on the 

icon you clicked. 

 
To reset the rotation angle value to 0°, click the number in the center of 

the Rotation icon in HQ. 

 

Editing Elements 

Audio Notes 

To record an audio note press record once. Press the record button a second time 

to stop recording.  You can playback your note by pressing the play button.  

 

The red center of the record button will be bright red 

 

Pressing record again will erase any previously recorded notes and start recording 

a new note. 

 

To delete the audio note click the Clear Audio Note button. 
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Creating Clips from Video and Autolog 

A.  Set Start 

B.  Set End 

C.  Select All 

 

1. Click on the line or drag the blue marker to where you want to start you clip.  

 

2. Press the Set Start button. The part of the original video you are not including in 

your clip will turn red.  

 

3. Click on the line or drag the blue marker to where you want to end your clip.  

 

4. Press the Set End button.  

 

5. You have the option to create a clip without its original audio. To omit the original 

audio check the box next to Mute Clip. 

6. Click Save Clip to create your clip.  

 The time it will take to create the clip will depend on the clip’s 

length (See Clip Duration).  

Once your clip has been created it will appear in green in the Media Element List. 
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Photo Markup 

 

 

a. Save: Saves changes made to the photo and adds it to the Media Elements 

List as a modified element in green. 

 
b. Revert: saves the modified photo without any mark-up or edits. 

c. Undo 

d. Redo 

e. Fit to Window 

f. View Actual Size 

g. Zoom in by 10% 

h. Zoom out by 10% 

i. Current view size 

j. Image Effects 

 Brightness / Contrast 

 Sharpness 

 Emboss 

k. Pen 

l. Text 

m. Rotate/Move 

n. Apply: accepts any changes made with tools (j) through (m) 

o. Cancel: cancels any changes made with tools (j) through (m) 
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Importing Elements 

You can drag photos and videos from your computer directly into the Media 

Element List of a job window. Imported elements will show up in the Media 

Elements list in tan. 
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Report 

Creating Reports 

Standard 

Standard Reports can be emailed, printed, or exported as PDF/HTML. 

In the Standard Report dropdown menu select what template you want to use for your 

report. The sizes associated with both Auto and Basic reports affect the size/dimensions of 

the media and not the file size of the finished report.  

DVD 

You can create your own custom DVD templates by clicking the Settings Gear 

Upload 

 

Distributing Reports 

Email 

 

Emailing Individual Media Elements 

You can email photos, standard and autolog videos that do not exceed 20MB. Photos will 

be attached as jpeg and both video types will be attached as avi files.  

 

Print 

 

Export 
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PDF 

HTML 

Upload 

 

Burn 

 


